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I. Quick Reference Guide

The Guide described below is written as a Quick Reference.  Detailed software instructions are 
provided.

Comet Assay Setup:

1. Serially number assay slides, starting at 1 and increasing up to the maximum number of slides in 
the study.

• Detailed experimental records should correspond to each well (ex. A1) by row (A), column (1) 
and slide.

Image Capture:

2. Collect images for a given Study using the same exact equipment and settings.

• Camera should be operated in a fixed gain mode, at the lowest gain setting practical.

• Camera should have a linear response to light input.

• Use longest exposure avoiding saturation of undamaged heads.

• Capture images at 4X or 10X with comet head to left and tail to right.

• Save images as TIFF, JPEG or PNG.

Software Analysis:

3. Test protocol definition for number of comets found on both an untreated and treated image.

• Using the Comet Wizard select Other Tasks> Protocol Definition. 

• If necessary, create new protocol definition to increase number of comets found.

4. Create a new study (Wizard Step 1).

5. Add Images to study using the Well Explorer (Wizard Step 2).

6. Scan images (Wizard Step 3).

7. Review and edit comets (Wizard Step 4).

8. Print or export study results (Wizard Step 5).



www.RnDSystems.com 1

INTRODUCTION
The CometAssay® Analysis Software, simplifies assay performance from end-to-end, and 
assures sensitive, consistent quantitative results, within, and across successive comet assay 
experiments or screening studies.

The ability of chemical substances such as pesticides, metals, polycyclic aromatic hydrocarbons 
(PAHs), solvents, gasoline additives, etc. to induce mutations and DNA damage in prokaryotic 
and eukaryotic cells has created the need to test these chemicals for their genotoxic potential 
before being used as products, and therefore released into the environment. Conventional 
methods for evaluating genetic damage, including chromosomal aberration, micronucleus 
assay and their sister chromatid exchanges are time consuming, resource intensive and require 
proliferating cell populations. Hence, cost effective and more sensitive test systems have now 
been introduced for assessing the genotoxicity of chemicals. 

The single cell gel electrophoresis or “comet assay” is one such state-of-the-art technique for 
quantitating DNA damage and repair in eukaryotic cells and some prokaryotic cells. This 
technique is rapid, non-invasive, sensitive, visual and inexpensive compared to conventional 
techniques and is a powerful tool to study factors impacting mutagenicity and carcinogenicity. 
It is the only technique that directly measures DNA damage in individual cells and as a result 
has rapidly gained importance in the fields of genetic toxicology and human and 
environmental bio-monitoring. The assay measures double strand breaks (DSBs), single strand 
breaks (SSBs), alkali labile sites, oxidative DNA base damage, DNA-DNA/DNA-protein/DNA-
Drug cross-linking, and DNA repair. The following figure summarizes the basic steps in the 
assay

Cells mixed with low
melting agarose at 
37 °C (LM Agarose)

Immobilze cells on
CometSlide

Treat cells with Lysis 
Solution (removed 
membranes and 
histones from the DNA)

Samples treated with
alkali (unwinds and 
denatures DNA)

Samples stained with
intercalating dye and visualized 
by epi�orescence microscopy
following alkaline
electrophoresis, which reveals
DNA breaks

The term “comet assay,” stems from the comet like appearance that cells with DNA damage take 
on following the electrophoresis step in the assay, when stained with an intercalating 
fluorescent dye, and visualized by epifluorescence microscopy.
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Cells embedded in low melting point agarose, plated onto microscope slides, are lysed with 
detergent and high salt to form immobilized nucleoids containing supercoiled loops of DNA 
linked to the nuclear matrix. Single or double strand breaks in the DNA, caused by damaging 
agents or conditions, may lead to loss of supercoiling and fragments of DNA freed from the 
nuclear matrix. When placed in an electrophoretic field, these uncoiled strands and fragments 
of DNA migrate through the agarose and extend toward the anode of the electrophoresis 
apparatus. Cells possessing DNA damage, consequently, present a comet like appearance, with 
a nucleoid head and a streaming tail of damaged DNA. Fluorescent intensities seen in the 
structures are proportionate to the quantities of DNA present.  Cells lacking DNA damage, 
appear simply as approximately circular fluorescent nucleoid heads with no tail.

The assay can be performed under neutral or alkali conditions, with the neutral version of the 
assay being principally useful for revealing double strand breaks, and the alkali version 
providing utility to examination of both single and double strand breaks. 

In both versions of the assay, increasing levels of DNA damage lead to increasing amounts of 
DNA (i.e., increasing fluorescent brightness) being found in the tail, and an increase in the 
visual tail length. Furthermore, DNA found at the end of the tail is indicative of more damage 
than an equivalent amount of DNA found at the start of the tail. This is because, under 
electrophoresis, the smaller DNA fragments will migrate through the agarose faster, and 
therefore further, than will larger DNA fragments; and, a larger number of strand breaks are 
required to produce a population of small fragments than are required to produce an 
equivalent mass of larger DNA fragments. 

The assay can be scored manually, on an epifluorescence microscope, using visual assessments 
of tail lengths and simple count based measures, such as the percent of cells exhibiting a tail. 
However, the speed, range and sensitivity of DNA damage assessments can be greatly 
enhanced by using a digital camera to transduce the microscopic fluorescent scene into digital 
images, amenable to automated analysis by a computer, equipped with software capable of 
generating more sophisticated and powerful quantitative measures of DNA damage, based on 
a detailed analysis of the distributional properties of the DNA related to each cell.

CometAssay Analysis Software provides the computational power to efficiently analyze digital 
images presenting fields of cells run in the comet assay The Software applies state of the art 
image processing methods to automatically locate scorable cells, and generate powerful 
analytic measures on each, to characterize and quantify the degree of DNA damage revealed 
by the comet assay. In addition to tail length, these measures include: 
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MEASURE DESCRIPTION

Tail Area The total projected area of the comet tail, coupling both tail length and width in a single measure.

Integrated Cell Intensity The total fluorescent intensity in the cell, providing an index of total cellular DNA content, useful for 
cell cycle assessments.

Percent DNA in the Tail The integrated tail intensity times 100 divided by the total integrated cell intensity providing a 
normalized measure of the percentage of total cellular DNA found in the tail.

Tail Moment The product of distance and intensity integrated over the tail length for a damage measure combining 
the amount of DNA in the tail with the distance of migration (severity of damage).

Tail Moment Arm The tail moment divided by the integrated tail intensity to measure the average distance of DNA 
migration within the tail.

Tail Moment of Inertia The distance squared times the intensity, integrated over the length of the tail. Similar to the tail 
moment, but providing further emphasis on the migration distance for added sensitivity.

Fragmentation Measures the relative texture or roughness of the fluorescent cell intensity providing an index of the 
total fragmentation of cellular DNA in both the head and tail combined.

The CometAssay® Analysis Software can rapidly evaluate large numbers of cells, related to each 
treatment group or screening target in a study, and generate summary statistics based on the 
corresponding numeric results. 

The software is specially engineered to complement and operate as the computational 
component of the standardized CometAssay System, which offers an array of products 
designed to facilitate sensitive, easy and consistent performance of the comet assay. The 
power, ease and speed of analysis offered by the software will be especially appreciated when 
coupled with the high throughput CometChip® technology.

 This manual provides instructions on the proper use of CometAssay Analysis Software. The 
Software is designed to work under the Microsoft Windows™ Operating System (Windows 10, 
Windows 8/8.1, Windows 7), and this manual assumes that the reader is familiar with the basic 
features and use of this operating system. 

Note: The software is provided for use under the terms of an End User Software Licensing 
Agreement. This Agreement may be viewed at the end of the manual. 
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PRECAUTIONS AND LIMITATIONS
CometAssay™ Analysis Software is For Research Use Only. Not for use in diagnostic 
procedures.

MATERIALS SUPPLIED
• CometAssay Analysis Software (USB dongle)

• CometAssay Analysis Software Installation Manual

MATERIALS/EQUIPMENT REQUIRED BUT NOT SUPPLIED
• Windows 10, Windows 8/8.1, Windows 7 with latest service pack (32-bit or 64-bit editions)

• Intel or AMD 1.5 GHz or faster processor with SSE2, SSE3 and SSE4 supported (multi-core 
processor recommended)

• 2 GB RAM (4 GB or higher recommended)

• 2 GB hard disk space (5+ GB recommended)

• 1024 x 768 resolution with 16-bit color display (1366 x 768 resolution with 24-bit or higher 
color display recommended)

• DirectX 9 or higher compatible audio card with latest driver

• Internet connection required for online features and tutorial videos

• Windows compatible CD/DVD drive for data archive

PREPARATION FOR QUALITY ANALYSIS
CometAssay Analysis Software provides the computational power to efficiently analyze digital 
images presenting fields of cells run in the comet assay. The Software applies state of the art 
image processing methods to automatically locate scorable cells, generate powerful analytic 
measures on each, and to characterize and quantify the degree of DNA damage revealed by 
the comet assay. Application of even the most advanced software image processing 
techniques can do little to compensate for poor quality preps or images. Considerable care and 
attention must be given up front to the production of quality comet assay sample preparations 
and to the collection of quality images from such preps, for analysis. 
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QUALITY COMET ASSAY SAMPLE PREPARATION

The quality of results achieved by application of the CometAssay® Analysis Software depends 
first and foremost on the quality of the sample preparations to be analyzed. Many factors can 
introduce unwanted variations into comet assay preps, if not properly controlled. Some of the 
more important factors include the quality and consistency of reagents used, the stability of 
agarose adherence to the substrates/slides used to support the samples during processing, the 
level and consistency of temperature across samples during electrophoresis, buffer height, 
electrode spacing, and the time, level, and consistency of the electric field applied. 

The CometAssay, or single cell gel electrophoresis assay, provides a simple and effective 
method for evaluating DNA damage in cells. The principle of the assay is based upon the ability 
of denatured, cleaved DNA fragments to migrate out of the nucleoid under the influence of an 
electric field, whereas undamaged DNA migrates slower and remains within the confines of the 
nucleoid when a current is applied. Evaluation of the DNA “comet” tail shape and migration 
pattern allows for assessment of DNA damage. The Neutral CometAssay is typically used to 
detect double-stranded breaks, whereas the Alkaline CometAssay is more sensitive, and is used 
to detect smaller amounts of damage including single and double-stranded breaks.

The CometAssay uses the CometSlide™ that is specially treated to promote adherence of low 
melting point agarose. This eliminates the time consuming and unreliable traditional method 
of preparing base layers of agarose. The use of the CometSlide shortens assay time and allows 
the rapid and reliable analysis of large numbers of samples. Slides are available in 2, 3, 20 and 
96 well formats.

In comet assays, cells are immobilized in a bed of low melting point agarose, on a CometSlide. 
Following gentle cell lysis, and for the Alkaline CometAssay, samples are treated with alkali to 
unwind and denature the DNA and hydrolyze sites of damage. For both assays, cells are lysed 
and the remaining nucleoids are subjected to electrophoresis and subsequent staining with a 
fluorescent DNA intercalating dye. It is recommended to use the CometAssay Alkalkine Control 
Cells (R&D Systems, Catalog # 4256-010-CC) when performing alkaline electrophoresis, and 
CometAssay Neutral Control Cells (R&D Systems®, Catalog # 4257-010-NC) when performing 
the neutral comet assay, to monitor assay conditions and verify reproducibility between 
separate runs. SYBR Gold for DNA visualization by epifluorescence microscopy is 
recommended.

For high throughput processing, the 96-Well CometChip System can be used in place of the 
CometSlides. The CometChip is a platform to simultaneously treat and measure DNA damage 
induced by different treatments, to one or more cell types, on a single slide using the comet 
assay. The CometChip is an array of spatially encoded micropores patterned on agarose. 
Ninety-six separate macrowells, each containing ~400 usable micropores, are created by 
inserting the CometChip into a magnetically sealable cassette. Cells added to each macrowell 
are deposited by gravity into the micropores.  Excess cells once removed, leave a pattern of 
non-overlapping cells. 
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Multiple experimental conditions are performed and evaluated in parallel by the addition of 
different chemicals to respective wells. Once treatment is complete and the CometChip 
removed from the magnetic cassette, a CometAssay LMAgarose overlay is added to immobilize 
the cells within the micropores. When performing the Alkaline CometAssay, the CometChip is 
immersed in Lysis Buffer for gentle cellular lysis, followed by Alkaline Solution to unwind and 
denature the DNA and hydrolyze sites of damage. Comets are developed by alkaline 
electrophoresis.

Whether using the CometSlide or the CometChip, we recommend the use of the CometAssay 
Electrophoresis System II (R&D Systems®, Catalog # 4250-050-ES) which is designed to 
eliminate known causes of assay variability. The electrophoresis step is performed using an 
Alkaline Electrophoresis Solution pH > 13, for the alkaline version, whereas a Neutral 
Electrophoresis Buffer is recommended for the neutral version.

Subsequent staining with SYBR Gold, a fluorescent DNA intercalating dye, allows visualization 
of the comet tail shape for assessment of DNA damage by fluorescence microscopy. Note, 
there are many fluorescent dyes that could potentially be used to label the DNA and the 
CometAssay Analysis Software is compatible with each. The use of SYBR Gold is recommended, 
as it is an ultra-sensitive nucleic acid gel stain, 25-100 times more sensitive than ethidium 
bromide, with demonstrated capabilities to detect as little as 25 pg of DNA. It exhibits > 
1000-fold fluorescence enhancement upon binding to nucleic acids and has a high quantum 
yield (~0.6) upon binding to double- or single-stranded DNA. Excitation maxima for dye-
nucleic acid complexes are at ~495 nm and ~300 nm and the emission maximum is ~537 nm. 
SYBR Gold stain is a proprietary unsymmetrical cyanine dye produced by ThermoFisher™ 
Scientific and is supplied as a 10,000 X concentrate in DMSO.

Quantitative and statistical data can readily be generated by analysis of the sample preps using 
the CometAssay Analysis Software which is designed to analyze digital images captured with a 
scientific grade digital camera via epifluorescence microscopy. The software automatically 
locates cells within the images and calculates tail length, percent DNA in the tail, and tail 
moment, among other parameters.

The CometAssay may be coupled with the FLARE™ (Fragment Length Analysis using Repair 
Enzymes) Assay which provides the added ability to probe for specific types of DNA damage 
using DNA repair glycosylases. 

Note: As slides are prepared for a study, the slides should be serially numbered, starting at 1 and 
increasing up to the maximum number of slides in the study. Detailed records of the experimental 
conditions corresponding to each well on each slide in the study should also be made for 
subsequent reference. Wells should be designated by the row (A, B, C,…) and column (1,2, 3,…) in 
which they appear on the slide.
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QUALITY IMAGE CAPTURE CONSIDERATIONS

To be amenable to computer analysis, quality digital images of the comet assay preps must be 
captured from each well, at an appropriate microscopic scale. These digital images constitute 
numeric arrays of measurements relating to the spatially distributed fl uorescent intensities 
presented by the subject samples and refl ecting the corresponding distribution patterns of 
cellular DNA, following electrophoresis and staining of the samples.

The signal-to-noise ratio (SNR) is a widely accepted metric for the quality of the measurements 
represented in a digital image. The SNR expresses how well the signal of interest is 
distinguished from background noise. It also relates directly to the level of uncertainty that 
exists in the measurements, and therefore the degree of confi dence that can be placed in the 
measurement results. SNR is heavily infl uenced by the characteristics of the overall system, and 
methods, used to obtain the images. Although this subject can be somewhat complex, there 
are several key factors to keep in mind: the SNR depends on the signal relevant photon number 
arriving at the sensor used to capture the image, combined with the sensor’s ability to 
effi  ciently and faithfully convert those photon arrivals into digital signals, and how well sources 
of unwanted noise can be suppressed.

The following will discuss various aspects of the typical equipment and methods used to 
capture computer analyzable images of comet preps from the aspect of maximizing the SNR 
(i.e. maximizing the relevant signal amplitudes, while at the same time minimizing the level 
and relative eff ects of sources of noise). The goal here is to give the reader a fundamental 
understanding of the technology and processes involved  to aid the reader in the selection and 
operation of appropriate equipment for quality comet image acquisition.

MICROSCOPE CONSIDERATIONS

The typical setup used to visualize and capture images of comet assay preparations is an 
epifl uorescence microscope equipped with a digital camera, as shown in the diagram. The key 
functional components of such a system are a high power, UV and near UV rich, light source 
(generally a xenon arc lamp or a mercury-vapor lamp), an excitation fi lter, a dichroic mirror (or 
beam-splitter), an objective lens, an emission fi lter and a scientifi c grade digital camera.
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The filters and the dichroic mirror must be chosen carefully to match the spectral excitation 
and emission wavelengths of the fluorophore used to label the DNA. A dichroic mirror is an 
optical device which will reflect certain wavelengths of light and pass others. The light source, 
excitation filter, dichroic mirror and objective lens constitute the illumination (or excitation) 
arm of the system. 

The light source will typically have associated mirrors, lenses and diaphragms, which aid in the 
effective collection and direction of light from the source to the sample. It is important that 
these optical elements are all properly aligned and adjusted to provide a bright even 
illumination within the plane of the sample. The light source itself must be properly maintained 
and adjusted to maximize brightness and to minimize fluctuations of the source. 

Intense broad-spectrum light from the source is projected to the excitation filter, where it is 
filtered to obtain narrow band light, centered at a wavelength (generally in the UV or near UV 
region of the spectrum) appropriate to excitation of the fluorophore. This light is then directed 
by the dichroic mirror through the objective lens, where it is concentrated and focused onto 
the comet prep. A portion of this light is absorbed by the fluorophore molecules labeling the 
DNA, causing them to fluoresce and emit light of a longer wavelength.

A fraction of the fluorescence light emitted by the comet sample is then collected by the 
objective lens and focused through the dichroic mirror and emission filter onto the light 
sensitive pixel array of the imaging sensor in the camera. The narrow band emission filter helps 
to eliminate any extraneous (unwanted) light from the true fluorescent signal of interest. The 
objective lens, emission filter, and camera, therefore, constitute the detection arm of the 
system. Note that both the illumination and detection arms of the epi-fluorescent microscope 
system share the objective lens. 

It is important to use an objective designed for fluorescence work, which effectively passes the 
UV and near UV wavelengths of light required for the excitation of most fluorophores. The 
optical lens elements in these objectives are typically made of quartz, fused silica, or another 
specialty glass that has high transmittance at UV and near UV wavelengths. Less expensive 
objectives designed strictly for bright-field microscopy will frequently have poor light 
transmission characteristics at these wavelengths and should not be used.

The numerical aperture (NA) of the objective lens characterizes the solid angle over which it 
can accept or emit light. For greatest sensitivity it is important to use a quality objective lens 
with a high NA. The intensity of the excitation light incident on the sample, and hence the 
effective excitation and fluorescent molecular brightness of the sample (i.e. the average 
number of photons emitted by the sample per unit time) will change as the square of the NA. 
Similarly, the light collection power of the objective changes as the square of the NA. Therefore, 
the emitted light flux reaching the sensor in the camera is proportional to the 4th power of the 
NA of the objective, at a given magnification. However, the light flux at the sensor is also 
inversely proportional to the square of the objective’s magnification (M). Therefore, the 
ultimate number of emitted light photons reaching the sensor in the camera is proportional to 
(NA)4/M2.



For research use only. Not for use in diagnostic procedures.9

CAMERA CONSIDERATIONS

As stated earlier, the microscopic scene visualized by the epifluorescence microscope is 
projected by the objective through the emission filter and focused onto the sensor chip in the 
attached camera, where the actual digital image capture takes place.  It is important that the 
investigator have a basic understanding of digital camera technology, so that they may 
evaluate the appropriateness of any particular camera for quality comet image acquisition and 
have the requisite knowledge to configure and operate the camera employed to best effect.

The camera is typically interfaced to a computer through appropriate high-speed 
communications electronics, which allows for computer control of the camera’s various 
features and capabilities and permits communication of captured images to the computer for 
archive and analysis.

The key component in a digital camera is the digital imaging sensor. A digital imaging sensor 
typically consists of millions of photo-sensitive picture elements or “pixels” fabricated on a 
semiconductor chip and organized in a planar two-dimensional array. The function of the 
imaging sensor is to convert the optical (photon) signal emitted from the sample and focused 
onto the pixel array, during an exposure period, into corresponding (proportionate) electrical 
signals for conversion into a digital signal by means of an analog-to-digital converter (ADC).

 The optical to electrical signal transduction is accomplished by Einstein’s photoelectric effect, 
in which impinging photons interact with the semiconductor material of the sensor, to 
produce electron hole pairs, sometimes referred to as photo-electrons. During the exposure 
period the electrons (or holes) produced are captured and stored locally in tiny capacitive 
potential wells, as an accumulated charge packet. These charge packets are subsequently 
transferred out to an amplifier, which reads the accumulated charge packets and transforms 
them into amplified voltages that are presented to an ADC for digitization. Depending on the 
specific camera design, the ADC may quantize the voltage signals into digital signals with 8 to 
16 bits of precision. Generally, the higher the bit depth the better, as this helps to minimize the 
introduction and magnitude of quantization errors.

The charge generated in a pixel is proportional to the total number of photons striking the 
pixel. It is a function of the duration of light exposure (integration time), the quantum 
efficiency of electron hole pair production at the detected wavelength, and most importantly 
the concentration and light intensity of the fluorophore at the sample. The charge generated is 
also affected by the size of the pixel. In general, larger pixels can capture more photons and 
generate more charge. However, larger pixels come at the expense of lower effective spatial 
resolution. 
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Lower spatial resolution, however, is not necessarily a bad thing, if matched properly to the 
spatial needs of the imaging application. Some cameras even offer the flexibility of being able 
to combine or “bin” groups of pixels locally within the array to create larger “super-pixels” 
whose aggregate charge can be read out as if from a single pixel. 2 X 2, 3 X 3, and 4 X 4 binning 
are the most common binning configurations offered. This ability allows the user to trade off 
spatial resolution for superior radiometric performance. The larger super-pixels offer greater 
light collection efficiency and dynamic range, while the reduced number of total pixels enables 
lower effective readout rates, which has benefits in terms of lower read noise, as will be 
discussed subsequently.

Another important consideration is the fill factor of the camera’s sensor. Due to sensor 
architecture, the entire surface of the pixels may not be photo-sensitive, as associated circuitry 
such as shift registers and amplifiers may take up a portion of each pixel’s real estate. The fill 
factor of an image sensor describes the relation of a pixel’s light-sensitive area to its overall 
area. Low fill factors reduce the effective light collection size of the pixel, without a 
corresponding improvement in spatial resolution. In some camera systems, micro-lenses are 
added to each pixel to better collect photons and focus them onto the photosensitive regions 
of the pixels, improving the effective fill factor. 

Another, approach to overcoming low fill factors, is the thinned, back-illuminated sensor. In this 
type of sensor, the back side of the sensor chip is etched away to create a very thin sensor that 
can be illuminated from the back side of the chip, thus avoiding any photon blocking ancillary 
circuitry, and bringing the effective fill factor to 100%. The downside of thinned back-
illuminated sensors is that they are very fragile and generally more expensive than non-
thinned sensors, because of the added processing required to produce them and lower 
production yields due to their fragility.

Another important consideration is the fact that there is a limit on the maximum signal 
amplitude that can be recorded at a pixel during any given exposure period. The full-well 
capacity (FWC) refers to the charge storage capacity at each pixel. This is the maximum number 
of electrons it can collect before saturation. Reaching saturation is analogous to a bucket being 
filled with water to the point of overflow. Generally, larger pixels, like larger buckets, have a 
greater FWC than small pixels (typically about 1,400 e- for each square micron of pixel area).

Electrons exceeding the FWC of a pixel are lost and cannot be quantified. In some instances, 
this excess charge can leak into, and contaminate the signals in adjacent pixels, causing an 
effect known as blooming. Some sensors contain anti-blooming electronics, which act to bleed 
off any excess charge and prevent corruption of adjacent pixels. As pointed out earlier, spatial 
resolution is sacrificed for larger pixels and thus higher FWC, which in turn influences the 
dynamic range of the sensor/camera as discussed below.
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A sensor/camera characteristic, directly related to full-well capacity, is the dynamic range. 
Dynamic range describes a camera system’s ability to simultaneously record low and high 
intensity signals. For the comet assay a large dynamic range is a major benefit.  In practical 
terms, this means that the weaker signals, often found in comet tails, are not lost in the noise 
produced by the camera, and the brightest signals, commonly found in comet heads, do not 
saturate the sensor. Mathematically the dynamic range is defined as the FWC divided by the 
camera generated noise. The dynamic range improves if the full-well capacity is higher and the 
noise produced by the camera is lower. 

There are two major types of noise produced by camera systems of concern. These are “thermal 
dark current noise” and “readout noise” or simply “read noise”. 

Thermal dark current noise is a fundamental noise phenomenon seen in all sensors based on 
the photo-electric effect. Sensor pixels will gradually accumulate charge whether the sensor is 
being exposed to light or not.  This is commonly referred to as dark current or dark current 
noise, as it is independent of any incoming optical (light) signal. It is caused by random, 
thermally generated, electrons (or holes) that build up in the pixels.  The rate of dark current 
accumulation depends principally on the temperature of the sensor. With short exposure 
periods, the effects of dark current may be minimal. However, with longer exposure periods 
dark current can use up a significant portion of the charge storage capacity at each pixel. Given 
enough time and temperature, dark current will progressively fill every pixel in the sensor up to 
its FWC. 

 Managing dark current noise is particularly important for low light imaging applications, like 
the comet assay, because the weak fluorescence signals often require long exposure times. 
Fortunately, the rate of dark current noise accumulation can be reduced significantly by cooling 
the sensor, approximately halving the rate of dark current accumulation with every 8˚C of 
cooling. 

A common method of cooling sensor chips, employed by camera manufacturers, is the use of 
compact multistage solid-state thermoelectric heat pumps, based on the Peltier Effect. Using 
such devices, sensor chips can be cooled by 45 ˚C or more from ambient temperatures, 
reducing the rate of dark current accumulation by a factor of 100 or more. It is also common for 
sensor fabricators to mask a subset of pixels, along the edge of the pixel array, with an opaque 
material, preventing any light input, so that any residual dark current buildup can be isolated 
and measured. This can then be subtracted from the other un-masked pixels in the array during 
readout and digitization.

Read noise, on the other hand, originates from the electrical readout circuitry of the sensor/
camera involved in amplifying and quantifying the signal into digital values. Read noise is 
independent of the optical signal and the pixel integration time.
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The read noise can generally be reduced by lowering the pixel readout rate, which defines how 
fast charge is read out from the pixels. Lower readout rates allow amplifiers and associated 
electronics more time to settle and reset between pixel reads, resulting in more stable, less 
noisy, performance. Some cameras offer the ability to alter read out rates enabling the cameras 
to be optimized for a fast readout mode, when dealing with dynamic phenomena, or a slower 
low noise mode when dealing with a relatively static low light imaging application, such as the 
comet assay.

A pixel’s accumulated charge is read out as a tiny voltage, on the order of microvolts per 
accumulated electron (or hole). Before being passed to the ADC, the camera amplifies these 
pixel voltages to levels appropriate for the ADC. All amplifiers will introduce some noise to a 
signal in the amplification process. Amplifiers can also distort signals, providing different 
amounts of amplification depending on the input signal level. A well-designed amplifier, 
however, will exhibit high linearity (no distortion) and introduce only minimal noise. The noise 
that the amplifier introduces will generally scale with the gain of the amplifier, being greater at 
high gain settings. High gain settings also reduce the effective dynamic range of the camera. 
Consequently, it is generally beneficial to operate a camera at the lowest gain setting practical.

A few words of caution are appropriate here, with respect to signal amplification. 

Some camera systems can operate in an auto-gain mode in which the camera will dynamically 
set the gain of the system, according to the average brightness of the scene being imaged, or 
some other scene specific property (minimum brightness, maximum brightness, etc.).  
Auto-gain destroys the ability to rationally compare photometric measures obtained in one 
image to those obtained in another, because it applies a different (and unknown) level of 
amplification to each image.  
Note: While useful for some dynamic imaging applications, auto-gain mode should never be used 
when employing the camera for a quantitative photometric application, such as comet assay. For 
quantitative applications, the camera should be operated in a fixed gain mode, at the lowest gain 
setting practical.

Some cameras also feature a capability called gamma correction, which enables a user to 
intentionally distort the camera’s output signal relative to its input optical signal. For example, 
by increasing the gamma setting of the camera (gamma > 1), the user can cause the camera to 
apply more gain to low level optical signals than to high, within a scene. Lowering the gamma 
setting to values less than 1 causes the reverse to happen.  
Note: For a quantitative photometric application, such as comet assay, it is very important that the 
camera provides a linear (non-distorted and proportional) response to input optical signals. In other 
words, the camera should have a gamma of 1.

There is a fundamental limitation to the performance that can be provided by any camera 
system, which stems from the quantum nature of light. “Shot noise” (also known as "quantum 
noise" or "photon noise") describes the random fluctuations in the number of photons 
detected by a sensor.
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This phenomenon is best illustrated by imagining you are trying to catch rain drops in a bucket, 
during a fi xed period of time, in a steady rain.  If you now repeat this experiment over and over 
many times, you would fi nd that the bucket does not capture exactly the same number of 
drops each time. This is not the fault of the bucket (i.e. the sensor), but is instead the 
consequence of the discrete and stochastic nature of rain, in terms of droplets. If you were to 
statistically analyze the results of this rain experiment, you would fi nd that the standard 
deviation (σ) of the number of drops captured by the bucket, across all the trials, is 
approximately equal to the square root of the average number of drops captured. In other 
words, the fl uctuations are in accordance with a Poisson probability distribution.

Similarly, with respect to a pixel in a sensor, each photon impact (and production of a 
photo-electron) constitutes a discrete independent event. Therefore, the charge accumulation 
at the pixel during any given period of time cannot be precisely predicted; instead the charge 
accumulation during any given exposure period is governed by a Poisson probability 
distribution. This is not the fault of the sensor. It is a direct consequence of the discrete and 
stochastic nature of light, in terms of photons. 

Even if a perfect sensor could be produced, where all mechanisms of camera induced noise are 
absent, the sensor’s optical signal detection would still be "photon noise limited," as the shot 
noise remains. Shot noise is inherent to the detection of light. There is no camera design 
change or operational trick that can change this fact. Furthermore, higher signal levels will 
exhibit higher levels of shot noise.

However, consider the following. If the exposure time used to measure a signal is increased, the 
expected number of photon detections will increase accordingly, and the shot noise will also 
rise. The rate of shot noise increase is slower than that of the signal, as the magnitude of shot 
noise increases according to the square root of the expected number of events. This means the 
relative proportion of shot noise, as compared to the detected signal, decreases. In other 
words, the relative uncertainty in the signal level measurement declines as the signal level rises. 
Consequently, the Signal-to-Noise Ratio (SNR) improves, resulting in better quality images.
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IMAGE COLLECTION

Quality digital images of the comet assay preps from each well on the various Study slides 
must be captured, to facilitate analysis. As indicated earlier, these digital images constitute 
numeric arrays of measurements relating to the spatially distributed fluorescent intensities 
presented by the subject samples and reflect the corresponding distribution patterns of 
cellular DNA, following electrophoresis and staining of the samples. The patterns recorded in 
these images are used by the CometAssay® Analysis Software Application to identify scorable 
cells and generate corresponding measures of DNA damage.

To aid in the acquisition of quality measures of DNA damage, the following serves as a 
guide to capture images from comet assay preparations:

1. Use a properly aligned and maintained epifluorescence microscope to visualize assay cells 
at an appropriate microscopic magnification in the range 4X to 10X.

2. Use an objective magnification that assures at least 20 pixels span the nuclear diameter 
of a typical undamaged (negative control) cell, to make sure images are captured with an 
adequate spatial resolution to support the reliable calculation of DNA damage measures 
from the cells.

3. Use an excitation filter, emission filter, and dichroic mirror with spectral bandpass 
properties appropriate for the fluorophore used to label the DNA.

4. Use a quality fluorescence grade objective lens with a high numeric aperture to maximize 
signal (emitted fluorescent light) delivery to the camera sensor.

5. Use a quality scientific grade digital camera that provides a linear response to light inputs 
for digital image capture.

6. Use a digital camera that has an adequately cooled sensor to reduce thermal dark current 
noise to minimal levels.

7. Use a digital camera whose sensor is micro-lensed, thinned and back illuminated, or 
otherwise has an architecture that offers a high effective fill factor, which maximizes the 
effective light sensitive real estate of the sensor.

8. Use a camera with sufficiently large pixels to provide effective light collection, a reasonable 
FWC and high dynamic range or, if the feature is available, use binning to configure “Super-
pixels” that can accomplish the same.

9. Operate the camera in a fixed gain mode to assure stable image to image performance.

10. Operate the camera at the lowest gain setting practical to help minimize read noise.

11. Use the lowest pixel readout rate offered by the camera to help minimize read noise.

12. Use the longest exposure (integration time) practical, consistent with the brightest cell 
features (undamaged nucleoid heads) not saturating sensor pixels, to minimize the relative 
effects of shot noise and maximize SNR.
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13. Collect all images for a given Study using the same exact equipment and settings, to assure 
comparability of results. CometAssay Analysis Software accepts TIFF, JPEG and PNG image 
formats.

14. During image collection, mount comet slides on the microscope stage such that the comet 
heads are to the left side of the camera view and the comet tails are extending to the right. 
Rotation of the camera in its mount may be necessary at the start to achieve proper align-
ment of the camera with the cells and with the orthogonal motions of the microscope 
stage.

15. Conventional guidance is that 50 or more cells should be analyzed from each treatment 
group (Well) to provide reliable statistics, therefore, images providing coverage of 75 or 
more cells should be acquired to provide a safety margin for possible cell crowding and 
other factors that may reduce the yield of scorable cells.

16. When collecting multiple images from a Well, avoid overlap between images, to reduce the 
probability of duplicate scoring of the same cells.

17. When saving captured images, name them in a manner that permits the slide and well from 
which they were collected to be easily identified. For example, three Tiff format images col-
lected from Well A1 on slide 5 in a Study might be named 5A1_1.tif, 5A1_2.tif, and 5A1_3.tif.

CometAssay® Analysis Software is designed to accommodate the input of images from a wide 
variety of digital camera types and brands. It can accept images of various sizes, encoded in the 
most common digital file formats (Tiff, JPEG, and PNG) used to communicate and store images.

Note: The software does not provide capabilities for direct control of any particular camera type or 
brand for image capture. This must be accomplished outside of CometAssay Analysis Software, 
using camera specific image capture software, typically supplied by the manufacturer of the camera 
employed.
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COMPUTERIZED COMET ASSAY ANALYSIS 
When the CometAssay Analysis Software is installed on a computer, the installation program creates a 
“Comet” folder on the C drive of the computer’s hard disc. This folder holds the Comet Application 
executable fi le (CometApplication.exe) and various other fi les required for the proper operation of the 
software. The installation program also creates a “Studies” folder within the Comet folder. The purpose 
of this folder is to hold folders specifi c to each comet study analyzed by the software.

The installation program also creates a Comet Application Icon on the computer desktop.

To launch the Comet Application, double left-click on the Application icon. This will open the 
Application’s Main Window, as shown below.

The Main Window features a graphic of a stylized comet and provides text identifying the company and 
application name, along with contact information. It also provides text references along the bottom of 
the window to the CometAssay Standardized System and CometChip High Throughput System, both of 
which are compatible with Comet Assay Analysis Software. All the text elements on this window are 
active. If the computer has internet access, left-clicking on any of these text elements will open a web 
browser at the corresponding product information webpage. These links provide the user with ready 
access to information, products and protocols that make the conduct of comet assays faster, easier, 
more sensitive and more reliable.

Along the top of the main window is the Title Bar. This displays the application name, and next to this 
the name of the currently active Study, if any, is shown. The Title Bar also shows information on the 
number of slides and the slide format (2-, 3-, 20-, or 96-Wells) used in the active study. 

Immediately below this is the menu bar, which provides access to the various functions and tools that 
are used when working with the application. The sections that follow will discuss the use of these 
various menu options in the context of processing a CometAssay Study.
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NEW STUDY CREATION

When a new Study is created or initialized, the Comet Application will dynamically create a set 
of folders in which to hold all the Study related data, including all the image fi les to be 
analyzed for a given Study (or experiment). The image related folders are organized in a nested 
structure that logically relates to the number and type of CometSlide used for the subject 
Study, as specifi ed by the application user. 

Each image fi le to be analyzed by the software corresponds to an individual well (or treatment 
region) on one of possibly multiple slides within a given Study. Each well may have one or 
more image fi les related to it. Dependent on the slide type used, each slide may have two or 
more wells (or treatment regions). These are generally arrayed or organized in a row and 
column structure on the glass surface of the slide. Any individual well on a particular slide type 
can be uniquely identifi ed by specifi cation of the row and column in which it appears. Rows 
have a letter designation (A, B, C, …) and columns have a numeric designation (1, 2, 3, etc…). 
The fi gure below shows the various slide types and the arrangement of wells on each.
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When the FILE > New Study is selected from the main window, the program launches the 
Define New Study Window, which allows the user to input three Study defining pieces of 
information: a unique Study Name, the total number of slides in the Study, and the well format 
of the CometSlide or CometChip used. This last input is facilitated by a pull-down Slide Type 
menu which lists each of the different formats as options. The window also requires the 
identification of a Protocol File by way of a pull-down Protocol List menu. A Protocol File lists a 
set of parameters used by the application to configure its search and analysis routines. These 
protocol files will be discussed in more detail later in this manual. When the user is finished 
inputting the required information, the Save button should be left-clicked.

The program will then create a Study (or experiment) specific “Study” folder, named in 
accordance with the user supplied <Study Name>. This folder resides within the “Studies” 
folder which is found within the “Comet” folder. 

Within the newly created Study folder, the program creates a “Slides” folder, which contains a 
separate folder for each slide in the study. These folders follow the naming convention of  
< Slide_Number> (i.e., Slide_1, Slide_2, ...). 

Within each Slide folder, the program creates a separate folder for each well (or treatment 
region) on the slide, in accordance with the following naming convention: < Well_Row Letter 
Designation Column Number Designation> (i.e., Well_A1, Well_A2, …, Well_B1, Well_B2, …). 

The “Well” related folders serve as holding places for the images to be analyzed by the 
program. Once the folders are created for a particular study, the user may directly place images 
into these folders (independent of the program), as the images are collected (digitally 
captured), or the user may subsequently move images into these folders, from an intermediate 
image storage location, with the aid of a programmatic image assignment and review interface 
referred to as the “Well Explorer”.
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Study database files created during subsequent analysis are also stored and accessed from 
within the Study folder or its nested (Slide or Well) Folders, as appropriate. The Study folder 
serves to encapsulate all the data related to a specific Study in one convenient place. This 
facilitates archiving and retrieval of study data by program users. The newly created Study will 
become the active Study and its name will be listed in the Title Bar on the Main Application 
Window.

Note: The total data storage needs of individual Studies can be quite large. So at some point, after a 
number of Studies have been created and analyzed, it may be necessary to move the data related to 
prior studies out of the studies folder, and onto removable storage media, such as a DVD, or to other 
archive storage locations, to make room for new studies to be analyzed. This can be most easily 
accomplished by moving the entire Study folder related to a target Study to the alternate storage 
location. This will keep all the data related to that Study together. If in the future this data needs to 
be accessed, the Study folder can be copied back into the Studies folder, in the Comet folder, for 
processing by the Comet Analysis Application. Study data can also be moved between multiple 
Comet Analysis Workstations in this manner.

OPENING AN EXISTING STUDY

The user can open a previously created Study by selecting FILE > Open Study from the Main 
Window. The application will launch an Open Study Window, which lists all the available 
studies found in the Studies Folder. This list also details the date that each study was created 
and the number of slides in each study. To open a particular study, left-click on the chosen 
Study Name in the list, to highlight it, and then left-click on the Open Study button at the lower 
right of the window. The Open Study Widow will then close, the selected Study will become 
the active Study in the application, and its name will appear on the Title Bar of the Main 
Window.
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IMAGE ASSIGNMENTS USING THE WELL EXPLORER

Before the Application can analyze the images related to a particular study, they must be 
loaded into the appropriate Slide Well folders on the computer, so that they can be accessed by 
the Application. 

Selecting FILE > Activity > Well Explorer from the Main Window will cause the application to 
launch the Well Explorer Window, which enables users to easily review the image file content of 
the Slide Well folders, related to the active Study. It also provides the capability for a user to 
browse for and copy the appropriate image files into these folders from other (intermediate) 
storage locations. 

The names of the currently active Study and its assigned Protocol file are displayed near the 
top of this window. A button, to the right of these enables the user to Change Protocol file, if 
desired. When this button is left-clicked, the application will bring up a sub-window with a pull 
down list of the available (previously created) Protocol files from which the user may choose a 
new file. 

Immediately below the Study and Protocol file names, on the Well Explorer Window, are two 
pull down lists that enable the user to select the Slide No. and Well ID of interest. A list box, 
below these, shows the names of the image files, if any, assigned to the currently selected slide 
well.

To the right of the list box, a picture of the CometSlide type (2-, 3-, 20-, or 96-well), used in the 
active Study, is displayed. In the example shown, this picture is of a 96 Well format slide.  A 
glance at the slide picture provides the user with information on the image assignment status 
of the various wells on the active slide. Those Well folders corresponding to the currently 
selected slide, which have one or more images already assigned to them, are indicated on the 
picture by a dark brown coloring of the associated wells. Those wells, whose folders have no 
images yet assigned, are shown in white. The currently selected (or active) well is shown in a 
light brown or cream color. This is the well, for which the image files, shown in the list box on 
the left, correspond. A legend at the bottom of the window summarizes the different well color 
treatments and what they mean. 
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In addition to using the previously discussed Well ID pull down list, to select the active Well, the 
user can select the active Well by simply left-clicking on the desired Well, on the slide picture. 
When this is done, the images, if any, then assigned to the Well will be displayed in the list box 
on the left.

Image files shown in the list box can be examined by left-clicking on the file of interest, to 
highlight it, and then left-clicking on the Open File Button, located immediately below the 
image list box. This will cause the default application for displaying image files on the 
computer to open a window, which will display the image. Similarly, if an image assignment 
has been made in error and the user wishes to delete an image from the Well folder, the user 
simply needs to left-click on the Delete File Button, below the list box, after highlighting the file 
in the list. Caution: The file will be deleted from the current Well folder, so the user may want to 
make sure the image is backed-up at another location before performing this action.

To add one or more images to a target Well folder, the user simply needs to left-click on the 
corresponding well on the slide picture. This will make that Well the currently active Well. The 
user then needs to left-click on the Browse Button, found in the lower left region of the Well 
Explorer Window. This will open a standard Windows browsing window that the user can use to 
navigate to the intermediate directory location used to store image files during image capture 
from the Study sample preps.

The user then needs to select the specific image or images, associated with the target well, in 
the browse window. A single image can be selected by left-clicking on the corresponding file 
shown in the browse window, or multiple images can be selected by left-clicking on the first of 
the desired image files and then shift left-clicking on any additional image files. Once the 
target images have been selected, the user then needs to left-click on the Open button in the 
browse window. The selected images will then be copied into the targeted Well folder and the 
image files appearing in the image file list box shown on the left of the Well Explorer Window 
will be updated.
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An alternative method for loading images into their appropriate Well folders is to use the 
Windows Explorer App to open the intermediate image storage location (directory), and then 
to drag and drop the image files (one at a time or in groups) directly onto the target wells on 
the Slide picture shown in the Well Explorer Window. If the intermediate image storage 
location (directory) is not on the desktop an image copy is made before being moved to the 
Well folders. Caution:  Files stored on the desktop are physically moved to the Well folders, 
consequently, a back-up copy will no-longer exist at the original desktop storage location

When the user is finished making and reviewing image assignments to the various well folders, 
he or she can left-click the button marked “Done,” to exit the Well Explorer Window.

SCAN MODE

Once all the images have been loaded into their appropriate Slide Well folders, the Study is 
ready to be scanned. During scan the application will systematically retrieve the images from 
the Slide Well folders and apply state of the art image processing methods to automatically 
locate scorable cells, and generate powerful analytic measures on each, to characterize and 
quantify the degree of DNA damage revealed by the comet assay. 

Selecting FILE > Activity > Scan Mode from the Main Window will cause the application to 
launch the “Scan Mode” Window.

This window identifies the name of the currently active Study and associated Protocol File at 
the top of the window. To the right of these, it also provides a Change Protocol button to 
change the Protocol File, if desired. Below these is a table that has one row for each of the Wells 
to be analyzed. Each row identifies the slide number on which the Well resides, the well name, 
the path to the Well Folder within the Current Study Folder, the number of Comets found in the 
Well, and the Well’s Scan Status. Note before actually starting the scan process the number of 
Comets found will be listed as “0” for each Well, and the associated Scan Status will be listed as 
“Not Started.” To start the scan process left-click on the “Start Scan” button found at the lower 
right of the window. 
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The application will then work its way down the table, retrieving and analyzing images from 
the associated Well Folders. As it progresses down the table, it will display each image, in a 
“Search Images” Window, as it is analyzed, placing a white box around each valid cell/comet 
found and updating the “Comets Found” count in the table on the Scan Mode Window. As it 
analyzes images it will also in some cases place boxes of another color around potential 
comets. These are cells that were rejected from analysis for several possible reasons: bad cell 
morphology, cell crowding or overlap that compromises reliable damage measure assessment, 
cells too close to the image border for proper analysis, or interfering debris. The application 
also generates a variety of measures on each valid cell/Comet found, such as Tail Length, 
%DNA in the Tail, Tail Moment, etc. and writes these values into a database for subsequent 
review and statistical analysis. When it completes analyzing all the images associated with a 
particular Well, it updates the Scan Status for that Well in the table to “Completed,” and then 
moves on to the next Well, if any, in the Study.

When the application is finished analyzing all the images in the Study, the user can review the 
cells/Comets found on each image if they desire. By left-clicking on the row corresponding to 
the Well of interest in the Scan Mode Window, the set of images related to that particular Well 
can be called-up in the Search Images Window. Each separate image related to the selected 
Well will have its own tab along the top of the image display area of the window. By left-
clicking on these image tabs the image of interest can be selected for display. Found valid  
cells/Comets will be marked with a white box.

REVIEW AND EDIT

Selecting FILE > Activity > Review and Edit from the Main Window will provide the user with 
access to a group of windows used in the review and editing of the comet analysis results. The 
primary windows in this group include: 

1. The Review and Edit Window

2. The Numeric Results Window

3. The Review Comets Window

4. The Search Images Window

5. The Edit Comet Window
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The first three of these windows open simultaneously when the user enters the Review and 
Edit activity. They work in conjunction with each other to allow a user to systematically and 
efficiently review all the comet data generated during the analysis of a study. Actions 
performed on any one of these windows generally effects the range or focus of information 
displayed on the others. 

The Review and Edit Window provides a summary table that lists the number of comets found 
(and analyzed), in each well, on the various slides in the active Study.  It is the Window used to 
navigate between Wells, when reviewing the analytic results produced in Scan Mode.  Left-
clicking on and highlighting a row in the table, corresponding to a particular Well in the Study, 
results in that Well’s data being displayed in the companion windows. The user can also 
advance forward or backward through the successive Wells by left-clicking the “Next Well” and 
“Previous Well” buttons near the top left of the window. As will be discussed further, below, 
using the companion windows, specific comets can be excluded from consideration, if there is 
a problem, such as an error in the identification of a valid Comet by the application. When a 
comet is excluded, the count in the table column labeled “Comets Included” is decremented.  
The table also has a column that lists the “Review status” of each Well. When a user is finished 
reviewing and editing all the comets corresponding to a particular Well, the user can use (left-
click) the “Mark Well” button to change the Review Status of the Well from “Not Started” to 
“Completed.” If a Well is marked as complete in error, the user can use the same button to 
unmark it. There is also a button to Mark all Wells as complete. Left-clicking the “Exit Review” 
button in the lower right corner of the Window or left-clicking on the X in the upper right 
corner will close the window and cause all the companion windows in the Review and Edit 
activity to close.

The quantitative measures of DNA damage generated from each comet in the selected well are 
displayed in a table on the Numeric Results Window. Each cell analyzed, within the currently 
selected Well, corresponds to an individual row in this table. Left-clicking on a row in this table 
results in that row being highlighted and the corresponding comet image in the Review 
Comets Window being selected and highlighted in green. If the Search Images Window 
(discussed previously in the Scan Mode section) is open, the corresponding cell on the original 
image will also be highlighted by a bold white box. The Search Images Window does not 
launch automatically, when entering the Review and Edit activity. It can be launched by 
selecting the Windows item on the menu bar at the top of the Main Window.
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The Review Comets Window shows images of each of the comets analyzed within a selected 
Well. Left-clicking on one of these images will make it the currently selected comet, as 
designated by a green highlight box that surrounds the image. The corresponding row in the 
Numeric Results Window and comet in the Search Images Window will also be highlighted, if 
these windows are open. The comet images shown in the Review Comets Window are 
displayed along with markers, which delineate the comet head and tail positions, used in 
generating associated measures of DNA damage. The start of the head has a white marker. The 
end of the head (or start of the tail) has a red marker. And, the end of the tail has a green 
marker. The user can edit the positions of the head end and tail end markers, if in the user’s 
opinion these need adjusting. 

To accomplish this, the user can double left-click on the comet to be edited or select the “Show 
Edit Comet Window” option from the Edit Mode menu found at the top left of the Review 
Comets Window. This will cause the Edit Comet Window to be launched, which shows an 
enlarged image of the selected comet, together with the subject markers. On this window the 
user can make adjustments to the head and tail marker positions, by left-clicking and dragging 
the markers to their desired positions. When this is done the measures of DNA damage for the 
comet are automatically recalculated and updated in the Numeric Results Window to reflect 
the new marker positions. A check mark will also be placed in the table row under the column 
labeled “Edited,” to show that the damage measures are the result of an edited tail. Selecting 
“Show Intensity Profile” from the File menu on the Edit Comet Window will cause an intensity 
profile plot to be superimposed on the enlarged comet image. The Edit Comet Window also 
provides the capability to alter the color mapping of the comet image, by way of the slider 
control on the left side of the window. Both capabilities can be helpful for assessing proper 
marker positions.  The File menu on this window also has an option to return the marker 
positions to their original positions (Restore Scanned Values) determined in Scan Mode.
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The Review Comets Window also provides the ability to completely exclude specific comets 
from the analysis results, if the object shown is not a valid comet or has some other problem 
requiring its exclusion. This can be accomplished by right-clicking on the comet to be 
excluded. A red X will appear over the image to show that it has been excluded. A check mark 
in the “Excluded” column on the Numeric Results Window will appear in the corresponding row 
to show that the comet is excluded. Right-clicking on a comet that has already been excluded 
will toggle it back to an included status. This same toggling action between exclude and 
include can also be accomplished from a Toggle Include Exclude option in the Edit Mode menu 
at the top of the Review Comets Window. 

The comet images viewed in the Review Comets Window can be displayed with intensity 
profile plots superimposed. The user needs can Show Intensity Profile from the Edit Mode 
menu near the top left of the Review Comets Window.

The user can copy the image of the currently selected comet shown in the Review Comets 
Window by selecting Edit > Copy Image to Clipboard, from the Main Window. The selected 
comet image can then be pasted into another application, such as Microsoft Word or Excel. 
Similarly, the numeric results (damage measures) related to the currently selected comet can 
be copied to the clipboard by selecting Edit > Copy Measure to Clipboard, from the Main 
Window.
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PRINT AND EXPORT NUMERIC RESULTS AND STATS

Select FILE > PRINT OR EXPORT to launch the Generate Report Window.

The Generate Report Window, shown below, provides the capability for the user to print out 
hardcopy reports and export data over the clipboard to an Excel Spreadsheet or other 
statistical package. In the top half of the window the user can left-click to toggle check boxes 
to specify the specific measures to be included in the report. In the lower half of the window 
the type of data to be included in the report can be specified. At the user’s option, the reports 
can include the raw comet by comet quantitative measures selected and/or summary statistics 
related to each well. The summary statistics include the minimum, maximum, median, mean, 
and standard deviation of the selected measures. The Protocol settings can also be included in 
the report printed or exported over the clipboard. Data can also be exported for individual 
measures to an Excel spreadsheet, pre-formatted for box-plot processing by Analyse-it, a third 
party statistical analysis add-on to Excel.

When the Print button is left-clicked, the application opens a standard printer window, which 
allows the user to select the printer to use, set printing preferences, specify the number of 
copies, etc. before finally printing the specified report.

When the Export button is left-clicked, the application copies the specified information to the 
computer clipboard and puts up a message when the action is complete. The user must then 
open a destination application, such as Microsoft Excel, and paste the data into the application.  
The figure below shows a raw data report corresponding to a single Well for a simple test Study 
that was exported to Excel.
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TOOLS AND MISCELLANEOUS FUNCTIONS
PROTOCOL CREATION AND EDITING

A Protocol File lists a set of parameters used by the Comet Analysis Application to configure its 
search and analysis routines.

The application uses a multi-dimensional classification model to distinguish scorable comets 
from other (non-target) objects found in comet assay images. The individual analytic 
dimensions of the classifier derive from characterizing measures acquired on objects found in 
the images, by the systematic application of a variety of mathematical image processing 
techniques. These techniques seek first to partition objects of potential interest from the 
background. They then derive a number of quantitative measures, which serve to characterize 
the found objects in terms of the various dimensions of the classifier. Quantitative limits, 
related to each analytic dimension, then allow the finding routines to classify a candidate 
object as either a scorable comet or a non-target object.

While the total process is rather complex, the underlying classification concept is simple to 
understand. The application basically asks and answers questions such as: Is this object that I 
found too small to be a comet? Is it too big? Is the long axis of the object oriented in a direction 
consistent with the direction of electrophoresis?  Is the object’s shape consistent with the 
expected shape of a comet? Is the object essentially symmetric about a horizontal line drawn 
through its center?  By asking and answering such questions, the application is able to 
systematically sieve through the objects found on each image and classify them as potentially 
scorable comets, or as non-target objects to be rejected from further consideration. The 
objects judged to be consistent with the characteristics of comets are passed on to additional 
software routines, which analyze and quantify the associated distribution of fluorescent 
intensities and derive various measures of DNA damage.

For the most part, the parameters specified in a Protocol file serve to define the quantitative 
decision points or limits on the various classification dimensions. In other words, they specify 
things like, how small is too small to be a comet, or how symmetric must an object be to be 
consistent with being a comet. 

The parameters in a Protocol file can be divided into two basic categories: parameters which 
are scale dependent, and parameters which are scale invariant. The scale invariant parameters 
are very stable and only need to be adjusted in rare circumstances. The scale dependent 
parameters are sensitive to factors such as the electrophoresis conditions, objective 
magnification of the microscope, and the digital camera’s sensor array type, size and resolution. 
For this reason, the CometAssay® Analysis Software is equipped with a utility for making 
adjustments to existing Protocol files to define and save new files. These new Protocol files can 
then be called up to configure the search and analysis routines of the application. To launch 
this Protocol Definition utility, the user must select Tools > Protocols Definition from the Main 
Window.
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The application will then bring up a window which allows the user to select an existing 
protocol file to modify, from a pull down Protocol List of the Protocol files available on the 
system.  
Note: The CometAssay™ Analysis Software comes supplied with a number of pre-defined Protocol 
files. These files relate to objective magnifications of 4X and 10X, for both alkali and neutral comet 
assays. These Protocols were optimized for a 3.3 megapixel camera with a 2048 X 1536 pixel sensor 
array and a 3.45 X 3.45 micron pixel size. 

After selecting the desired file to be modified the user should left-click on the OK button at the 
lower right of the Window. This will cause the application to launch the Protocol Definition 
window, as shown below:

This window displays the name of the selected Protocol File near the top left of the window. If 
the selected file is one of the pre-defined “Built In” Protocols discussed above a check will be 
shown in the box next to the words “Built In” just below the Protocol name, otherwise the box 
will be empty. Below the box will be two tabs. Left-clicking on the tab labeled General will 
cause the window to display the various scale dependent parameters, as shown above. We will 
discuss these parameters shortly, but first let examine what is displayed when the Advanced 
Tab is left-clicked, as shown below.
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With the Advanced Tab selected the window displays the various scale invariant parameters. 
The default values for these parameters have been optimized through extensive testing, and 
they should generally not be changed unless under consultation with technical support 
personnel. If by accident these parameters do get changed, there is a button that the user can 
left-click to Reset Default values.  The single parameter under the advanced tab which can be 
changed without guidance from technical personnel is the parameter labeled Fluorophore’s 
Spectral Region. Radio button controls allow the user to specify whether the fluorophore being 
used to label the DNA in their comet assay emit light in the Red, Green, or Blue region of the 
spectrum. The default setting is Green, as this is the region in which the recommended 
fluorophore, SYBR Gold, emits fluorescence. This information is needed to guide proper color 
channel selection when processing images from a color camera. This setting has no effect if the 
camera being used is monochrome.

Let’s now return our attention to the scale dependent parameters displayed when the General 
Tab is selected. These parameters define a search box size that is used when looking for comets 
in images. They also define size criteria such that objects too small or too large to be comets 
can be quickly eliminated from consideration. Proper setting of these parameters depends on 
the apparent scale of comets as seen by the user’s camera at a chosen objective magnification. 
Different cameras may see comets scaled differently, at the same microscope objective 
magnification, as a result of differences in the pixel count and array size of the cameras’ sensors. 
The easiest way to adjust for such camera differences is to measure a typical (average sized) 
undamaged comet head in an image captured with the subject camera at the chosen 
magnification. The application can then automatically compute appropriate parameter values 
based on this measurement. The Define Protocol Window, therefore, has a button labeled 
“Measure Head,” which when left-clicked will launch a Wizard message box which will walk the 
user through the head measurement process.

The initial Wizard message instructs the user to click on Select Image....button.

Doing so will cause a browser window to be launched so that an appropriate negative control 
image can be identified and selected. When this is done the user should click on the Open 
button.
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Once Open has been clicked, the Wizard will instruct the user to select a representative cell 
(Comet head) by first clicking on the “Select Cell” button. This will cause the selected image to 
be displayed. The user then needs to identify an appropriate cell in the image and left-click on 
the center of the head (cell nucleus).

Once this is done, an enlarged image of that cell will be displayed with two markers. The user 
should then drag the markers so that they align with the left (red) and right (green) edges of 
the head, as shown below and then left-click on the button labeled “Done.”
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The Wizard will then report on the measured head width and the newly calculated values for 
the various scale dependent parameters, as shown below. To accept these values the user clicks 
on the Finish button. To repeat the measurement process, the user can click on the Back 
button.

Once the user clicks on Finish, the Wizard message box will close and the parameters will be 
updated in the Protocol Definition Window.

The new Protocol parameter set can be tested against one or more images by using the “Test” 
button at the lower left of the Define Protocols Window. Clicking on this button will cause a 
browse window to launch, from which the user can locate and select an image for testing 
purposes. When the user clicks Open on the browse window, the selected image will be 
displayed and the comets found on the image will be marked by white boxes, as show below. A 
message box will also be displayed, which reports the number of comets found on the image.
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Note: The user is not locked into the computed parameter values.  
The user can fine tune the various parameters shown in the Define Protocol Window by directly 
typing new values into the parameters’ numeric display fields. For example, if in reviewing test 
images, the user feels that the box size used in searching for comets is too wide, the user can 
type in a smaller width specification and then run a test to see how the new value performs. 
Appendix A provides guidance on the reasonable range and default values for each of the 
parameters listed in the Define Protocol Window. 

The user can use the “Save as” button, to name and save the parameter settings in a new 
Protocol File, once suitable performance is achieved on the test images, so that they can be 
retrieved and applied to a full study at a later time.  The ability to import another previously 
saved Protocol File for review and refinement is provided by the “Open” button. The “Save” 
button allows the user to save a refined/updated protocol file under its prior name. And, the 
“Delete” button allows the user to delete an existing protocol file

Finally, the “Cancel” button allows the user to exit the interface when he or she has completed 
setting up Protocol Files. Pressing this button will also close any Test Image Window that is 
open.
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WINDOWS

The Windows menu item found on the Main Window, provides the user the capability to 
reopen certain windows after they have been closed. This menu item is primarily used in the 
Review and Edit activity where multiple interactive windows are simultaneously active. While in 
the Review and Edit activity, a user may want to temporarily close one or more of the active 
windows to reduce screen clutter or to focus specifically on an individual task. The windows 
menu item allows the user to reopen these windows as appropriate. The specific windows 
supported by this item are the Numeric Results Window, the Comet Review Window, and the 
Search Images Window.

WINDOWS MODE

From the Tools menu on the Main Window, Wizard Mode can be turned on or off. Wizard Mode 
provides access to the Comet Wizard, who can be a very helpful fellow.

The Comet Wizard is an artificially intelligent assistant that helps the users logically navigate 
the CometAssay® Analysis Software. The Wizard monitors everything that is done with respect 
to the creation, analysis, review, editing and reporting of each Study on the system and pops 
up at appropriate times to recommend to users what the logical next step is in the processing 
of each Study. Operating with Wizard Mode on is particularly useful to users new to the 
application. Many seasoned users will also find the Comet Wizard useful as it provides shortcuts 
to access most of the key functions of the CometAssay Analysis Software.

A typical Comet Wizard message is shown below.

In this example, the Wizard noticed that the user had not finished reviewing (and editing, if 
needed) all the results generated in a prior Scan Mode Analysis of the Study images. The Wizard 
is therefore recommending that the user reenter the Review and Edit area of the application to 
complete the task. If the user wishes to follow the Wizard's advice, all he or she needs to do is 
left-click the Yes button, and the Wizard will immediately take the user to the proper location in 
the application to complete the task. If the user wishes to do something else, the user can 
left-click on another task in the Wizard Messaging Window and the Wizard will take the user to 
the appropriate location in the application to complete that task. All the major tasks necessary 
for processing a Study are listed in the lower left of the window, in their logical order of 
performance. The user can also easily navigate to the application area used to edit an existing 
or define a new Protocol File. The user can Exit Comet from here.
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The user can also left-click on the Close Wizard button, which will leave the application in 
Wizard Mode, but will close the current Wizard Message Window. The user can then use the 
standard menu structure of the application to accomplish a task. The user can left-click on the 
check box next to “Turn off Wizard Mode.”  This will turn off Wizard Mode until such time as 
Wizard Mode is turned back on, by way of the tools menu in the Main Window.

HELP RESOURCES

The Help menu found on the Main Window of the application provides the user with ready 
access to this software instruction Comet Manual. It also provides access to an “About” feature 
which lists the software version number, Copyright information and a contact link to website.
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COMETASSAY ANALYSIS SOFTWARE END USER LICENSE AGREEMENT
This End User License Agreement, including the Order Form which by this reference is 
incorporated herein (this “Agreement”), is a binding agreement between R&D Systems, Inc. 
(”Licensor”) and the person or entity identified on the Order Form as the licensee of the 
Software (”Licensee”).

LICENSOR PROVIDES THE SOFTWARE SOLELY ON THE TERMS AND CONDITIONS SET FORTH IN 
THIS AGREEMENT AND ON THE CONDITION THAT LICENSEE ACCEPTS AND COMPLIES WITH 
THEM. BY CLICKING THE “ACCEPT” BUTTON OR CHECKING THE “ACCEPT” BOX ON THE ORDER 
FORM YOU (A) ACCEPT THIS AGREEMENT AND AGREE THAT LICENSEE IS LEGALLY BOUND BY ITS 
TERMS; AND (B) REPRESENT AND WARRANT THAT: (I) YOU ARE 18 YEARS OF AGE OR OLDER/OF 
LEGAL AGE TO ENTER INTO A BINDING AGREEMENT; AND (II) IF LICENSEE IS A CORPORATION, 
GOVERNMENTAL ORGANIZATION, OR OTHER LEGAL ENTITY, YOU HAVE THE RIGHT, POWER, 
AND AUTHORITY TO ENTER INTO THIS AGREEMENT ON BEHALF OF LICENSEE AND BIND 
LICENSEE TO ITS TERMS. IF LICENSEE DOES NOT AGREE TO THE TERMS OF THIS AGREEMENT, 
LICENSOR WILL NOT AND DOES NOT LICENSE THE SOFTWARE TO LICENSEE AND YOU MUST 
NOT DOWNLOAD OR INSTALL THE SOFTWARE OR DOCUMENTATION.

NOTWITHSTANDING ANYTHING TO THE CONTRARY IN THIS AGREEMENT OR YOUR OR 
LICENSEE’S ACCEPTANCE OF THE TERMS AND CONDITIONS OF THIS AGREEMENT, NO LICENSE IS 
GRANTED (WHETHER EXPRESSLY, BY IMPLICATION, OR OTHERWISE) UNDER THIS AGREEMENT, 
AND THIS AGREEMENT EXPRESSLY EXCLUDES ANY RIGHT, CONCERNING ANY SOFTWARE THAT 
LICENSEE DID NOT ACQUIRE LAWFULLY OR THAT IS NOT A LEGITIMATE, AUTHORIZED COPY OF 
LICENSOR’S SOFTWARE.

1. Definitions. For purposes of this Agreement, the following terms have the following 
meanings:

”Authorized Users” means solely those individuals authorized to use the Software pursuant to 
the license granted under this Agreement, as set forth on the Order Form, each of whom shall 
be provided with a copy of the Authorized User Terms of Use attached as Annex 1 and agrees 
to comply with and be bound by them.

”Documentation” means user manuals, technical manuals, and any other materials provided by 
Licensor, in printed, electronic, or other form, that describe the installation, operation, use, or 
technical specifications of the Software.

”Intellectual Property Rights” means any and all registered and unregistered rights granted, 
applied for, or otherwise now or hereafter in existence under or related to any patent, 
copyright, trademark, trade secret, database protection, or other intellectual property rights 
laws, and all similar or equivalent rights or forms of protection, in any part of the world.

”Licensee” has the meaning set forth in the preamble.

”Licensor” has the meaning set forth in the preamble.
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”Order Form” means the order form filled out and submitted by or on behalf of Licensee, and 
accepted by Licensor, for Licensee’s purchase of the license for the Software granted under this 
Agreement.

”Person” means an individual, corporation, partnership, joint venture, limited liability company, 
governmental authority, unincorporated organization, trust, association, or other entity.

”Software” means the software programs for which Licensee is purchasing a license, as 
expressly set forth in the Order Form.

”Term” has the meaning set forth in Section 9.

”Third Party” means any Person other than Licensee or Licensor.

”Update” has the meaning set forth in Section 6(b).

2. License Grant and Scope. Subject to and conditioned upon Licensee’s strict compliance with 
all terms and conditions set forth in this Agreement, Licensor hereby grants to Licensee a 
non-exclusive, non-transferable, non-sublicensable, limited license during the Term to use, 
solely by and through its Authorized Users, the Software and Documentation, solely as set 
forth in this Section 2 and subject to all conditions and limitations set forth in Section 4 or 
elsewhere in this Agreement. This license grants Licensee the right, exercisable solely by and 
through Licensee’s Authorized Users, to:

(a) Download, copy, and install in accordance with the Documentation one (1) copy of the 
Software on one (1) computer owned or leased, and controlled by, Licensee. In addition to 
the foregoing, Licensee has the right to make one copy of the Software solely for archival and 
backup purposes, provided that Licensee shall not, and shall not allow any Person to, install 
or use such copy other than if and for so long as the copy installed in accordance with the 
preceding sentence is inoperable and, provided, further, that Licensee uninstalls and 
otherwise deletes such inoperable copy(ies). All copies of the Software made by the Licensee:

(i) will be the exclusive property of the Licensor;

 (ii) will be subject to the terms and conditions of this Agreement; and

(iii) must include all trademark, copyright, patent, and other Intellectual Property Rights 
notices contained in the original.

(b) Use and run the Software as properly installed in accordance with this Agreement and the 
Documentation, solely as set forth in the Documentation and solely for Licensee’s internal 
business purposes. Such use is permitted only on the computer on which the Software is 
installed, at the physical location thereof and not via any remote access or other network.
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(c) Download or otherwise make one (1) copy of the Documentation and use such 
Documentation, solely in support of its licensed use of the Software in accordance herewith. 
All copies of the Documentation made by Licensee:

(i) will be the exclusive property of Licensor;

(ii) will be subject to the terms and conditions of this Agreement; and

(iii) must include all trademark, copyright, patent, and other Intellectual Property Rights 
notices contained in the original.

(d) Transfer any copy of the Software from one computer to another, provided that the 
number of computers on which the Software is installed at any one time does not exceed the 
number permitted under Section 2(a).

3. Third-Party Materials. The Software and/or Materials may include, facilitate delivery of, or 
depend on software, content, data, or other materials, including related documentation, that 
are owned by Persons other than Licensor (“Third-Party Materials”) and that are provided to 
Licensee on licensee terms that are in addition to and/or different from those contained in this 
Agreement (”Third-Party Licenses”). In any such case, Licensee’s rights and obligations relating 
to those Third-Party Materials are set forth in applicable Third-Party Licenses, e.g., use of 
Microsoft Excel® with the Software is subject to Licensee’s licensing arrangement with 
Microsoft Corporation. In using the Software, Licensee is bound by and shall comply with all 
Third-Party Licenses. Any breach by Licensee of any Third-Party License is also a breach of this 
Agreement and the licensors of those Third-Party Materials are beneficiaries of, and will have 
the right to enforce, this Agreement.

4. Use Restrictions. Licensee shall not, and shall require its Authorized Users not to, directly or 
indirectly:

(a) use (including make any copies of ) the Software or Documentation beyond the scope of 
the license granted under Section 2;

(b) provide any other Person, including any subcontractor, independent contractor, affiliate, 
or service provider of Licensee, with access to or use of the Software or Documentation;

(c) modify, translate, adapt, or otherwise create derivative works or improvements, whether 
or not patentable, of the Software or Documentation or any part thereof;

(d) combine the Software or any part thereof with, or incorporate the Software or any part 
thereof in, any other programs;

(e) reverse engineer, disassemble, decompile, decode, or otherwise attempt to derive or gain 
access to the source code of the Software or any part thereof;

(f ) remove, delete, alter, or obscure any trademarks or any copyright, trademark, patent, or 
other intellectual property or proprietary rights notices provided on or with the Software or 
Documentation, including any copy thereof;
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(g) except as expressly set forth in Section 2(a) and Section 2(c), copy the Software or 
Documentation, in whole or in part;

(h) rent, lease, lend, sell, sublicense, assign, distribute, publish, transfer, or otherwise make 
available the Software, or any features or functionality of the Software, to any Third Party for 
any reason, whether or not over a network or on a hosted basis, including in connection with 
the internet or any web hosting, wide area network (WAN), virtual private network (VPN), 
virtualization, time-sharing, service bureau, software as a service, cloud, or other technology 
or service;

(i) use the Software or Documentation in, or in association with, the design, construction, 
maintenance, or operation of any hazardous environments or systems, including:

(i) power generation systems;

(ii) aircraft navigation or communication systems, air traffic control systems, or any other 
transport management systems;

(iii) safety-critical applications, including medical or life-support systems, vehicle operation 
applications, or any police, fire, or other safety response systems; and

(iv) military or aerospace applications, weapons systems, or environments;

(j) use the Software or Documentation in violation of any law, regulation, or rule; or

(k) use the Software or Documentation for purposes of competitive analysis of the Software, 
the development of a competing software product or service, or any other purpose that is to 
the Licensor’s commercial disadvantage

5. Responsibility for Use of Software. Licensee is responsible and liable for all uses of the 
Software and Documentation through access thereto provided by Licensee, directly or 
indirectly. Specifically, and without limiting the generality of the foregoing, Licensee is 
responsible and liable for all actions and failures to take required actions with respect to the 
Software and Documentation by its Authorized Users or by any other Person to whom Licensee 
or an Authorized User may provide access to or use of the Software and/or Documentation, 
whether such access or use is permitted by or in violation of this Agreement.
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6. Maintenance and Support.

(a) Subject to Section 6(c), the license granted hereunder entitles Licensee to the basic 
software maintenance for a limited period of time following the date set forth on the Order 
Form as specified in the packaging for the Software, Documentation associated with the 
Software, the sales receipt or Licensor’s web site.  Licensee may offer to renew or extend the 
period of maintenance for an additional fee.

(b) Maintenance will include provision of such updates, upgrades, bug fixes, patches, and 
other error corrections (collectively, “Updates”) as Licensor makes generally available free of 
charge to all licensees of the Software then entitled to maintenance. Licensor may develop 
and provide Updates in its sole discretion, and Licensee agrees that Licensor has no 
obligation to develop any Updates at all or for particular issues, that Updates may change or 
delete features or functionality of the Software, and that the timing of an Updates is in 
Licensor’s sole discretion. Licensee further agrees that all Updates will be deemed Software, 
and related documentation will be deemed Documentation, all subject to all terms and 
conditions of this Agreement. Licensee acknowledges that Licensor may provide Updates via 
download from a website designated by Licensor and that Licensee’s receipt thereof will 
require an internet connection, which connection is Licensee’s sole responsibility. Licensor 
has no obligation to provide Updates via any other media. Maintenance does not include any 
new version or new release of the Software that Licensor may issue as a separate or new 
product, and Licensor may determine whether any issuance qualifies as a new version, new 
release, or Update in its sole discretion.

(c) Licensor reserves the right to condition the provision of maintenance, including all or any 
Updates, on Licensee’s registration of the copy of Software. Licensor has no obligation to 
provide maintenance, including Updates:

(i) for any but the most current version or release of the Software;

(ii) for any copy of Software for which all previously issued Updates have not been 
installed;

(iii) if Licensee is in breach under this Agreement; or

(iv) for any Software that has been modified other than by or with the authorization of 
Licensor, or that is being used with any hardware, software, configuration, or operating 
system not specified in the Documentation.

(d) Any purchase of “lifetime” maintenance applies only to use of computers on which the 
Software is installed during the one (1) year period following the date set forth on the Order 
Form.  This maintenance will continue for so long as that computer is used, but not longer than 
its industry-standard useful life.  Transferring the Software to another computer will terminate 
Licensee’s right to such maintenance.   Licensor may cease providing maintenance, including 
“lifetime” maintenance, if it ceases maintaining and supporting the Software.
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7. Collection and Use of Information.

(a) Licensee acknowledges that Licensor may, directly or indirectly through the services of 
Third Parties, collect and store information regarding use of the Software and about 
equipment on which the Software is installed or through which it otherwise is accessed and 
used, through (i) the provision of maintenance; and 

(ii) security measures included in the Software.

(b) Licensee agrees that the Licensor may use such information for any purpose related to 
any use of the Software by Licensee or on Licensee’s equipment, including but not limited 
to:

(i) improving the performance of the Software or developing Updates; and

(ii) verifying Licensee’s compliance with the terms of this Agreement and enforcing the 
Licensor’s rights, including all Intellectual Property Rights in and to the Software.

8. Intellectual Property Rights. Licensee acknowledges and agrees that the Software and 
Documentation are provided under license, and not sold, to Licensee. Licensee does not 
acquire any ownership interest in the Software or Documentation under this Agreement, or 
any other rights thereto, other than to use the same in accordance with the license granted 
and subject to all terms, conditions, and restrictions under this Agreement. Licensor reserves 
and shall retain its entire right, title, and interest in and to the Software and all Intellectual 
Property Rights arising out of or relating to the Software, except as expressly granted to the 
Licensee in this Agreement. Licensee shall safeguard all Software (including all copies thereof ) 
from infringement, misappropriation, theft, misuse, or unauthorized access. Licensee shall 
promptly notify Licensor if Licensee becomes aware of any infringement of the Licensor’s 
Intellectual Property Rights in the Software and fully cooperate with Licensor in any legal 
action taken by Licensor to enforce its Intellectual Property Rights.
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9. Term and Termination.

(a) This Agreement and the license granted hereunder shall remain in effect for the term set 
forth on the Order Form or until earlier terminated as set forth herein (the “Term”).

(b) Licensee may terminate this Agreement by ceasing to use and destroying all copies of the 
Software and Documentation.

(c) Licensor may terminate this Agreement, effective upon written notice to Licensee, if 
Licensee, breaches this Agreement and such breach: (i) is incapable of cure; or (ii) being 
capable of cure, remains uncured thirty (30) days after Licensor provides written notice 
thereof.

(d) Licensor may terminate this Agreement, effective immediately, if Licensee files, or has filed 
against it, a petition for voluntary or involuntary bankruptcy or pursuant to any other 
insolvency law, makes or seeks to make a general assignment for the benefit of its creditors or 
applies for, or consents to, the appointment of a trustee, receiver, or custodian for a 
substantial part of its property.

(e) Upon expiration or earlier termination of this Agreement, the license granted hereunder 
shall also terminate, and Licensee shall cease using and destroy all copies of the Software and 
Documentation. No expiration or termination shall affect Licensee’s obligation to pay all 
Licensee Fees that may have become due before such expiration or termination, or entitle 
Licensee to any refund, in each case except as set forth in Section 10.1(c)(ii).

10. Warranty Disclaimer.

(a) THE SOFTWARE AND DOCUMENTATION ARE PROVIDED TO LICENSEE “AS IS” AND WITH ALL 
FAULTS AND DEFECTS WITHOUT WARRANTY OF ANY KIND. TO THE MAXIMUM EXTENT 
PERMITTED UNDER APPLICABLE LAW, LICENSOR, ON ITS OWN BEHALF AND ON BEHALF OF ITS 
AFFILIATES AND ITS AND THEIR RESPECTIVE LICENSORS AND SERVICE PROVIDERS, EXPRESSLY 
DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS, IMPLIED, STATUTORY, OR OTHERWISE, WITH 
RESPECT TO THE SOFTWARE AND DOCUMENTATION, INCLUDING ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-INFRINGEMENT, 
AND WARRANTIES THAT MAY ARISE OUT OF COURSE OF DEALING, COURSE OF PERFORMANCE, 
USAGE, OR TRADE PRACTICE. WITHOUT LIMITATION TO THE FOREGOING, THE LICENSOR 
PROVIDES NO WARRANTY OR UNDERTAKING, AND MAKES NO REPRESENTATION OF ANY KIND 
THAT THE LICENSED SOFTWARE WILL MEET THE LICENSEE’S REQUIREMENTS, ACHIEVE ANY 
INTENDED RESULTS, BE COMPATIBLE, OR WORK WITH ANY OTHER SOFTWARE, APPLICATIONS, 
SYSTEMS, OR SERVICES, OPERATE WITHOUT INTERRUPTION, MEET ANY PERFORMANCE OR 
RELIABILITY STANDARDS OR BE ERROR FREE, OR THAT ANY ERRORS OR DEFECTS CAN OR WILL 
BE CORRECTED.
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11. Limitation of Liability. TO THE FULLEST EXTENT PERMITTED UNDER APPLICABLE LAW:

(a) IN NO EVENT WILL LICENSOR OR ITS AFFILIATES, OR ANY OF ITS OR THEIR RESPECTIVE 
LICENSORS OR SERVICE PROVIDERS, BE LIABLE TO LICENSEE OR ANY THIRD PARTY FOR ANY 
USE, INTERRUPTION, DELAY, OR INABILITY TO USE THE SOFTWARE; LOST REVENUES OR 
PROFITS; DELAYS, INTERRUPTION, OR LOSS OF SERVICES, BUSINESS, OR GOODWILL; LOSS OR 
CORRUPTION OF DATA; LOSS RESULTING FROM SYSTEM OR SYSTEM SERVICE FAILURE, 
MALFUNCTION, OR SHUTDOWN; FAILURE TO ACCURATELY TRANSFER, READ, OR TRANSMIT 
INFORMATION; FAILURE TO UPDATE OR PROVIDE CORRECT INFORMATION; SYSTEM 
INCOMPATIBILITY OR PROVISION OF INCORRECT COMPATIBILITY INFORMATION; OR 
BREACHES IN SYSTEM SECURITY; OR FOR ANY CONSEQUENTIAL, INCIDENTAL, INDIRECT, 
EXEMPLARY, SPECIAL, OR PUNITIVE DAMAGES, WHETHER ARISING OUT OF OR IN 
CONNECTION WITH THIS AGREEMENT, BREACH OF CONTRACT, TORT (INCLUDING 
NEGLIGENCE), OR OTHERWISE, REGARDLESS OF WHETHER SUCH DAMAGES WERE 
FORESEEABLE AND WHETHER OR NOT THE LICENSOR WAS ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

(b) IN NO EVENT WILL LICENSOR’S AND ITS AFFILIATES’, INCLUDING ANY OF ITS OR THEIR 
RESPECTIVE LICENSORS’ AND SERVICE PROVIDERS’, COLLECTIVE AGGREGATE LIABILITY UNDER 
OR IN CONNECTION WITH THIS AGREEMENTOR ITS SUBJECT MATTER, UNDER ANY LEGAL OR 
EQUITABLE THEORY, INCLUDING BREACH OF CONTRACT, TORT (INCLUDING NEGLIGENCE), 
STRICT LIABILITY, AND OTHERWISE, EXCEED THE TOTAL AMOUNT PAID TO THE LICENSOR 
PURSUANT TO THIS AGREEMENT FOR THE SOFTWARE THAT IS THE SUBJECT OF THE CLAIM.

(c) THE LIMITATIONS SET FORTH IN SECTION 11(a) AND SECTION 11(b) SHALL APPLY EVEN IF 
THE LICENSEE’S REMEDIES UNDER THIS AGREEMENT FAIL OF THEIR ESSENTIAL PURPOSE.

12. Export Regulation. The Software and Documentation may be subject to US export control 
laws, including the US Export Administration Act and its associated regulations. The Licensee 
shall not, directly or indirectly, export, re-export, or release the Software or Documentation to, 
or make the Software or Documentation accessible from, any jurisdiction or country to which 
export, re-export, or release is prohibited by law, rule, or regulation. The Licensee shall comply 
with all applicable federal laws, regulations, and rules, and complete all required undertakings 
(including obtaining any necessary export license or other governmental approval), prior to 
exporting, re-exporting, releasing, or otherwise making the Software or Documentation 
available outside the US.

13. US Government Rights. The Software is commercial computer software, as such term is 
defined in 48 C.F.R. §2.101. Accordingly, if the Licensee is the US Government or any contractor 
therefor, Licensee shall receive only those rights with respect to the Software and 
Documentation as are granted to all other end users under license, in accordance with (a) 48 
C.F.R. §227.7201 through 48 C.F.R. §227.7204, with respect to the Department of Defense and 
their contractors, or (b) 48 C.F.R. §12.212, with respect to all other US Government licensees 
and their contractors.
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14. Miscellaneous.

(a) All matters arising out of or relating to this Agreement shall be governed by and construed 
in accordance with the internal laws of the State of Minnesota without giving effect to any 
choice or conflict of law provision or rule. Any legal suit, action, or proceeding arising out of 
or relating to this Agreement or the transactions contemplated hereby (“Claim”) shall be 
instituted in the federal courts of the United States of America or the courts of the State of 
Minnesota in each case located in the City of Minneapolis and County of Hennepin, and each 
party irrevocably submits to the exclusive jurisdiction of such courts in any such legal suit, 
action, or proceeding. Service of process, summons, notice, or other document by mail to 
such party’s address set forth herein shall be effective service of process for any suit, action, 
or other proceeding brought in any such court.  Regardless of any statute of limitations or law 
to the contrary, and to the maximum extent permitted by applicable law, any Claim 
hereunder must be filed within one (1) year of the date on which the incident giving rise to 
such Claim occurred.  Any failure to file such Claim within this period shall constitute a waiver 
of the right to bring such Claim in any form.

(b) Licensor will not be responsible or liable to Licensee, or deemed in default or breach 
hereunder by reason of any failure or delay in the performance of its obligations hereunder 
where such failure or delay is due to strikes, labor disputes, civil disturbances, riot, rebellion, 
invasion, epidemic, hostilities, war, terrorist attack, embargo, natural disaster, acts of God, 
flood, fire, sabotage, fluctuations or non-availability of electrical power, heat, light, air 
conditioning, or Licensee equipment, loss and destruction of property, or any other 
circumstances or causes beyond Licensor’s reasonable control.

(c) All notices, requests, consents, claims, demands, waivers, and other communications 
hereunder shall be in writing and shall be deemed to have been given: (i) when delivered by 
hand (with written confirmation of receipt); (ii) when received by the addressee if sent by a 
nationally recognized overnight courier (receipt requested); (iii) on the date sent by facsimile 
or email (with confirmation of transmission) if sent during normal business hours of the 
recipient, and on the next business day if sent after normal business hours of the recipient; or 
(iv) on the third day after the date mailed, by certified or registered mail, return receipt 
requested, postage prepaid. Such communications must be sent to the respective parties at 
the addresses set forth on the Order Form (or to such other address as may be designated by 
a party from time to time in accordance with this Section 14(c)).

(d) This Agreement, together with the Order Form, constitutes the sole and entire agreement 
between Licensee and Licensor with respect to the subject matter contained herein, and 
supersedes all prior and contemporaneous understandings, agreements, representations, 
and warranties, both written and oral, with respect to such subject matter.
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(e) Licensee shall not assign or otherwise transfer any of its rights, or delegate or otherwise 
transfer any of its obligations or performance, under this Agreement, in each case whether 
voluntarily, involuntarily, by operation of law, or otherwise, without Licensor’s prior written 
consent, which consent Licensor may give or withhold in its sole discretion. For purposes of 
the preceding sentence, and without limiting its generality, any merger, consolidation, or 
reorganization involving Licensee (regardless of whether Licensee is a surviving or 
disappearing entity) will be deemed to be a transfer of rights, obligations, or performance 
under this Agreement for which Licensor’s prior written consent is required. No delegation or 
other transfer will relieve Licensee of any of its obligations or performance under this 
Agreement. Any purported assignment, delegation, or transfer in violation of this Section 
14(e) is void. Licensor may freely assign or otherwise transfer all or any of its rights, or 
delegate or otherwise transfer all or any of its obligations or performance, under this 
Agreement without Licensee’s consent. This Agreement is binding upon and inures to the 
benefit of the parties hereto and their respective permitted successors and assigns.

(f ) This Agreement is for the sole benefit of the parties hereto and their respective successors 
and permitted assigns and nothing herein, express or implied, is intended to or shall confer 
on any other Person any legal or equitable right, benefit, or remedy of any nature whatsoever 
under or by reason of this Agreement.

(g) This Agreement may only be amended, modified, or supplemented by an agreement in 
writing signed by each party hereto. No waiver by any party of any of the provisions hereof 
shall be effective unless explicitly set forth in writing and signed by the party so waiving. 
Except as otherwise set forth in this Agreement, no failure to exercise, or delay in exercising, 
any right, remedy, power, or privilege arising from this Agreement shall operate or be 
construed as a waiver thereof; nor shall any single or partial exercise of any right, remedy, 
power, or privilege hereunder preclude any other or further exercise thereof or the exercise of 
any other right, remedy, power, or privilege.

(h) If any term or provision of this Agreement is invalid, illegal, or unenforceable in any 
jurisdiction, such invalidity, illegality, or unenforceability shall not affect any other term or 
provision of this Agreement or invalidate or render unenforceable such term or provision in 
any other jurisdiction.
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(i) For purposes of this Agreement, (a) the words “include,” “includes,” and “including” shall be 
deemed to be followed by the words “without limitation”; (b) the word “or” is not exclusive; 
and (c) the words “herein,” “hereof,” “hereby,” “hereto,” and “hereunder” refer to this Agreement 
as a whole. Unless the context otherwise requires, references herein: (x) to Sections, Annexes, 
and Exhibits refer to the Sections of, and Annexes, and Exhibits attached to, this Agreement; 
(y) to an agreement, instrument, or other document means such agreement, instrument, or 
other document as amended, supplemented, and modified from time to time to the extent 
permitted by the provisions thereof and (z) to a statute means such statute as amended from 
time to time and includes any successor legislation thereto and any regulations promulgated 
thereunder. This Agreement shall be construed without regard to any presumption or rule 
requiring construction or interpretation against the party drafting an instrument or causing 
any instrument to be drafted. The Order Form and all Annexes referred to herein shall be 
construed with, and as an integral part of, this Agreement to the same extent as if they were 
set forth verbatim herein.

(j) The headings in this Agreement are for reference only and do not affect the interpretation 
of this Agreement.

ANNEX 1

AUTHORIZED USER TERMS OF USE

These Software Terms of Use (”Terms of Use”) govern your use of the Comet Assay Analysis 
Software (the “Software”), including all user manuals, technical manuals, and any other 
materials provided by Licensor, in printed, electronic, or other form, that describe the Software 
or its use or specifications (the “Documentation”) provided to you (”you” or “your”) for use 
pursuant to and subject to a software license agreement (the “Software License Agreement”) 
between R&D Systems, Inc. (”Licensor”) and your employer or other person or entity who owns 
or otherwise lawfully controls the computer on which the Software is installed (”Licensee”).

BY CLICKING THE “ACCEPT” BUTTON OR CHECKING THE “ACCEPT” BOX YOU: (i) REPRESENT THAT 
YOU ARE DULY AUTHORIZED BY LICENSEE TO ACCESS AND USE THE SOFTWARE; AND (ii) 
ACCEPT THESE AUTHORIZED USER TERMS AND AGREE THAT YOU ARE LEGALLY BOUND BY 
THEM. IF YOU DO NOT AGREE TO THESE TERMS OF USE, DO NOT CLICK THE “ACCEPT” BUTTON 
OR CHECK THE “ACCEPT” BOX AND YOU WILL HAVE NO LICENSE TO, AND MUST NOT ACCESS OR 
USE, THE SOFTWARE.
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1. License Grant. Subject to your strict compliance with these Terms of Use, Licensor hereby 
grants you a non-exclusive, non-transferable, non-sublicensable, limited license to use the 
Software solely in accordance with the Documentation, as installed on the equipment 
provided by Licensee and for Licensee’s internal business purposes. The foregoing licensee will 
terminate immediately on the earlier to occur of:

(a) the expiration or earlier termination of the Software License Agreement between Licensor 
and Licensee; or

(b) your ceasing to be authorized by Licensee to use the Software for any or no reason.

2. Use Restrictions. You shall not, directly or indirectly:

(a) use the Software or Documentation except as set forth in Section 1;

(b) copy the Software or Documentation, in whole or in part;

(c) modify, translate, adapt, or otherwise create derivative works or improvements, whether 
or not patentable, of the Software or any part thereof;

(d) combine the Software or any part thereof with, or incorporate the Software or any part 
thereof in, any other programs;

(e) reverse engineer, disassemble, decompile, decode, or otherwise attempt to derive or gain 
access to the source code of the Software or any part thereof;

(f ) remove, delete, alter, or obscure any trademarks or any copyright, trademark, patent, or 
other intellectual property or proprietary rights notices included on or in the Software or 
Documentation, including any copy thereof;

(g) rent, lease, lend, sell, sublicense, assign, distribute, publish, transfer, or otherwise provide 
any access to or use of the Software or any features or functionality of the Software, for any 
reason, to any other person or entity, including any subcontractor, independent contractor, 
affiliate, or service provider of Licensee, whether or not over a network and whether or not on 
a hosted basis, including in connection with the internet, web hosting, wide area network 
(WAN), virtual private network (VPN), virtualization, time-sharing, service bureau, software as 
a service, cloud, or other technology or service;

(h) use the Software or Documentation in, or in association with, the design, construction, 
maintenance, or operation of any hazardous environments or systems, including:

(i) power generation systems;

(ii) aircraft navigation or communication systems, air traffic control systems, or any other 
transport management systems;

(iii) safety-critical applications, including medical or life-support systems, vehicle operation 
applications, or any police, fire, or other safety response systems; and
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(iv) military or aerospace applications, weapons systems, or environments.

(i) use the Software or Documentation in violation of any law, regulation, or rule; or

(j) use the Software or Documentation for purposes of competitive analysis of the Software, 
the development of a competing software product or service, or any other purpose that is to 
the Licensor’s commercial disadvantage.

3. Compliance Measures.

(a) The Software may contain technological copy protection or other security features 
designed to prevent unauthorized use of the Software, including features to protect against 
use of the Software:

(i) beyond the scope of the license granted to pursuant to Section 1; or

(ii) prohibited under Section 2.

You shall not, and shall not attempt to, remove, disable, circumvent, or otherwise create or 
implement any workaround to, any such copy protection or security features.

4. Collection and Use of Information.

(a) Licensor may, directly or indirectly through the services of others, collect and store 
information regarding use of the Software and about equipment on which the Software is 
installed or through which it otherwise is accessed and used, by means of (i) providing 
maintenance and (ii) security measures included in the Software as described in Section 3.

(b) You agree that the Licensor may use such information for any purpose related to any use 
of the Software by you, including but not limited to: (i) improving the performance of the 
Software or developing updates; and verifying compliance with the terms of this Agreement 
and enforcing Licensor’s rights, including all intellectual property rights in and to the 
Software.

5. Intellectual Property Rights. You acknowledge that the Software is provided under license, 
and not sold, to you. You do not acquire any ownership interest in the Software under this 
Agreement, or any other rights to the Software other than to use the Software in accordance 
with the license granted under this Agreement, subject to all terms, conditions, and 
restrictions. Licensor and its licensors and service providers reserve and shall retain their entire 
right, title, and interest in and to the Software and all intellectual property rights arising out of 
or relating to the Software, subject to the license expressly granted to the Licensee in this 
Agreement. You shall use commercially reasonable efforts to safeguard all Software (including 
all copies thereof ) from infringement, misappropriation, theft, misuse, or unauthorized access.
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6. Disclaimer of Liability. IN NO EVENT WILL LICENSOR OR ITS AFFILIATES, OR ANY OF ITS OR 
THEIR RESPECTIVE LICENSORS OR SERVICE PROVIDERS, BE LIABLE TO YOU FOR ANY USE, 
INTERRUPTION, DELAY, OR INABILITY TO USE THE SOFTWARE. YOU ARE PROVIDED THE 
SOFTWARE PURSUANT TO THE SOFTWARE LICENSE AGREEMENT BETWEEN LICENSOR AND 
LICENSEE, SOLELY FOR THE BENEFIT OF LICENSEE AND AT LICENSEE’S DISCRETION. YOU 
ACKNOWLEDGE THAT YOU HAVE NO RIGHTS UNDER THAT AGREEMENT INCLUDING ANY 
RIGHTS TO ENFORCE ANY OF ITS TERMS. ANY OBLIGATION OR LIABILITY LICENSOR OR ITS 
AFFILIATES, OR ANY OF ITS OR THEIR LICENSORS OR SERVICE PROVIDERS, MAY HAVE WITH 
RESPECT TO YOUR USE OR INABILITY TO USE THE SOFTWARE SHALL BE SOLELY TO LICENSEE 
PURSUANT TO THAT AGREEMENT AND SUBJECT TO ALL LIMITATIONS OF LIABILITY SET FORTH 
THEREIN.

7. Export Regulation. The Software may be subject to US export control laws, including the US 
Export Administration Act and its associated regulations. You shall not, directly or indirectly, 
export, re-export, or release the Software to, or make the Software or Documentation 
accessible from, any jurisdiction or country to which export, re-export, or release is prohibited 
by law, rule, or regulation. You shall comply with all applicable federal laws, regulations, and 
rules, and complete all required undertakings (including obtaining any necessary export 
license or other governmental approval), prior to exporting, re-exporting, releasing, or 
otherwise making the Software available outside the US.

8. Governing Law. These Terms of Use are governed by and construed in accordance with the 
internal laws of the State of Minnesota without giving effect to any choice or conflict of law 
provision or rule (whether of the State of Minnesota or any other jurisdiction) that would cause 
the application of Laws of any jurisdiction other than those of the State of Minnesota.
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X. TROUBLESHOOTING FOR SOFTWARE
PROBLEM CAUSE SOLUTION
Windows for Edit Mode, Review and 
Edit, Numeric Results or Search Images 
are not arranged properly on screen.

User has freedom to move and resize 
windows as needed. Windows open to 
previous location.

To open windows to default position 
select TOOLS > Reset User Settings 
from Main Window.

“Search Image” window is not visible in 
“Review and Edit”. 

“Search Image” window does not open 
automatically in “Review and Edit”.

To open window select WINDOWS > 
Activate Search Images from Main 
Window.

Software is not calling end of head 
properly. Density profiles places marker 
either in middle of head or toward end 
of tail.

Incomplete DNA staining of internal 
region of comet head appears as 
donut. Density profile shows to peaks 
in head region.

Stain for one hour with 0.1X SYBR Gold.

Reduce the amount of distilled water 
in the Master Mix. Add 100 μL of this 
Master Mix and 50 μL of the extract to 
each well. 
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APPENDIX
APPENDIX A: RANGE AND DEFAULT VALUES FOR PROTOCOL PARAMETERS

• CometBoxHeight

o Range: Depends on image scale (2-3 times typical undamaged head diameter)

o Default: 2.3 times typical undamaged head diameter

• CometBoxWidth

o Range: Depends on image scale (3-5 times typical undamaged head diameter)

o Default: 4 times typical undamaged head diameter

• MaximumCellColumns

o Range: Depends on image scale (0.9-1.0 times CometBoxWidth)

o Default: 0.9 times CometBoxWidth

• MaximumCellRows

o Range: Depends on image scale (0.8-1.0 times CometBoxHeight)

o Default: 0.8 times CometBoxHeight

• MinColsToRowsRatio

o Range: 0.5-1.0

o Default: 0.7 

• MinimumCellColumns

o Range: Depends on image scale (0.1-0.4 times typical head diameter)

o Default: 0.3 times typical head diameter

• MinimumCellRows

o Range: Depends on image scale (0.1-0.4 times typical head diameter)

o Default: 0.3 times typical head diameter

• PercentCutoff

o Range: 0.5 - 5

o Default: 4
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• PotentialCellMaxCutoff

o Range: 245-255.

o Default: 255

• PotentialCellMinCutoff

o Range: 5-20 

o Default: 8

• SymmetryPercentTolerance

o Range: 10-35

o Default: 25

• SymmetryStdDeviation

o Range: 1-4

o Default: 2 

• TailAsymmeticPercent

o Range 20-50

o Default: 40

08.19 3094260.2 03/23

©2023 R&D Systems®, Inc.

All trademarks and registered trademarks are the property of their respective owners.


